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프로그램 실행파일 생성 (링킹)

프로그램 실행

 유지보수

01 
C 프로그래밍

C언어는 오늘날 가장 보편적으로 사용되고 있는 프로그래밍 언어 중 하나로, 매우 효율적인 상

위 레벨 언어이다. C 언어로 작성한 소스코드를 컴퓨터가 이해할 수 있는 기계어로 바꿔주는 번

역 소프트웨어인 컴파일러 중 Microsoft Visual Studio 2026과 Dev-C++ 5.11을 이용한 

프로그램의 작성방법을 살펴본다.

1. 프로그램 개발 단계

프로그램 설계

테스트와 디버깅

프로그램 번역 (컴파일)

학습개요

프로그램 목적 정의

프로그램 (소스코드) 작성

01  

02  

03 

04

05 

06 

07

08 



2. 프로그램 다운로드

< Microsoft Visual Studio 2026 : https://visualstudio.microsoft.com/ko/ > 

< Dev-C++  : https://sourceforge.net/projects/orwelldevcpp/ > 
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* [무료 다운로드 받기]를 클릭하면 Visual Studio Community 2026을 다운로드할 수 있다.



3. Microsoft Visual Studio 2026 에서의 프로그램 작성 예

< 1단계 : 작업공간 마련>

   프로젝트 생성 

   ① 상단 메뉴에서  파일 → 새로만들기 (N) → 프로젝트 (P) 선택

실행 시 초기 화면

1
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② ‘Windows 데스크톱 마법사’ 선택

③ 프로젝트 이름 입력 후 ‘만들기’ 버튼을 누름 
        - 프로젝트 이름을 입력함
           입력 예) Hello_project

       - 솔루션은 여러 개의 프로젝트를 담는 컨테이너로, 기본적으로 프로젝트 이름과  동일하게 
         입력되지만, 필요하다면 별도의 이름을 지정할 수 있다.

       - 프로젝트 관련 파일의 저장위치는           아이콘을 눌러 임의의 위치로 변경 가능. 
           입력 예) C:\
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④ 응용 애플리케이션 종류(T)에서 ‘‘콘솔 애플리케이션’을 선택하고, 추가 옵션 중 
      ‘빈 프로젝트’를 선택한 후 ‘확인’ 버튼 누름

⑤ ‘솔루션 탐색기’ 라는 것을 통해 작업공간이 마련된 것을 확인 할 수 있음
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< 2단계 : 소스파일 생성>

소스파일 정보 입력 
① ‘C++ 파일 (cpp)’을 선택
② 이름에 파일명.c로 확장자(.c)까지 입력 후 ‘추가’ 버튼 누름
      입력 예) hello.c

2

소스 코드를 작성할 수 있는 파일 생성
① 솔루션탐색기에서  ‘소스파일’ 폴더에 마우스 오른쪽 버튼 누름
② 추가 → 새 항목 선택

1
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3. Microsoft Visual Studio 2026에서의 프로그램 작성 예



소스코드 입력
– 반드시 오타가 없도록 하여 입력

아래와 같이 솔루션 탐색기의 소스파일 폴더 아래 hello.c 파일이 생성됨
- 에디터 창에 소스코드를 입력할 수 있는 상태가 됨

4

3
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< 3단계 : 솔루션 빌드 (컴파일과 링크) >

정상적인 빌드 (컴파일과 링크) 과정이 끝나면 하단부 메시지 창에
아래와 같은 결과가 나옴

2

상단 메뉴에서 빌드 → 솔루션 빌드(B) 선택1

- 오류가 발생했다면 하단부 메시지 창에 뜨는 오류메시지를 보고 해당 위치로 가서   
   수정 후 다시 1) 번의 ‘솔루션 빌드’ 수행
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3. Microsoft Visual Studio 2026 에서의 프로그램 작성 예



< 4단계 : 실행 파일 실행 >

방법1 또는 방법2로 실행하면 아래와 같은 결과 창이 뜸

방법 2) Ctrl + F5 키를 누름

2

방법1 또는 방법2 둘 중에 선택하여 실행
방법 1) 상단 메뉴에서 디버그 → 디버깅하지 않고 시작(H) 선택

1
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3. Microsoft Visual Studio 2026 에서의 프로그램 작성 예



4. Dev-C++ 을 사용한 프로그램 작성 예

< 1단계 : 소스코드 작성 후 저장>

프로그램 실행 후 상단 메뉴에서 ‘파일(F) → 새로 만들기(N) → 소스 파일(S)’ 선택1

에디터창에 소스코드 입력2
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상단 메뉴에서 ‘파일(F) → 저장(S)’ 선택3

소스 파일의 저장 위치를 선택하고 파일 이름(N)에 파일명.c로 확장자(.c)까지 
입력 후 ‘저장(S)’ 버튼 누름
입력 예) hello.c

4
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< 2단계 : 컴파일 >

상단 메뉴에서 ‘실행(Z) → 컴파일(C)’ 선택1

정상적인 컴파일 과정이 끝나면 하단부 컴파일 로그 창에 아래와 같은 결과가 나옴2
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4. Dev-C++ 을 사용한 프로그램 작성 예



< 3단계 : 실행>

상단 메뉴에서 ‘실행(Z) → 실행(R)’ 선택1

실행하면 아래와 같은 결과 창이 뜸2

01
 C

 프
로

그
래

밍

4. Dev-C++ 을 사용한 프로그램 작성 예



5. 에러와 경고

에러 (error)

경고 (warning)

1

2

- C언어의 문법 상 명백하게 잘못된 점이 있어 컴파일을 할 수 없는 경우
   에러 메시지를 출력하고 컴파일을 거부함
- 오탈자, C언어 문법에 맞지 않는 내용, 반드시 필요한 지정이 빠진 경우 등
- 에러 메시지가 출력된 경우 반드시 수정하여 재 컴파일을 해야만 실행 가능

- 코드의 내용이 의심스러워 보이기는 하지만 경미한 실수이 거나, 현재는 큰 문제가
  없지만 이식성에 불리하다거나 권장하지 않는 방법으로 소스 코드를 작성했을 때 
  경고 메시지를 출력
- 경고 메시지만 출력된 경우 타당한 지적이라면 수정하고 그렇지 않으면 무시해도 
   상관 없음. 즉, 경고를 무시해도 실행은 가능

※ Visual Studio 경고의 다른 예

- Visual Studio 2010 이상 버전부터 보안성을 강화한 get_s, scanf_s 함수 등을 제공함.
- 안전하지 않은 함수인  gets, scanf 대신 get_s, scanf_s를 사용하라는 warning
   메시지가 나오는 경우가 있음

방법 1 | 메뉴의 ‘프로젝트’ → ‘속성(P)’ → ‘구성 속성’ → ‘일반’에서
                 ‘SDL 검사’ 항목의 값을 ‘아니오(/sdl-)’로 변경
방법 2 | 아래의 코드를 삽입하면 그와 같은 메시지가 출력되지 않음
	 #include <stdio.h>
	 #pragma warning(disable:4996)   /* 좌측의 코드 삽입 */
               /* 위의 코드는 이외의 보안성 강화한 함수를 사용하라는 모든
                 warning 메시지 출력이 안 되도록 함*/

처리 방법
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6. C 프로그램의 기본구조

7. New Line (줄바꿈) 문자  ‘\n’의 사용 예

#include <stdio.h>

int main()

{

    int x, y, sum; /* 변수 선언문 */

    scanf(“%d”, &x); /* 변수 x를 입력 받음 */

    scanf(“%d”, &y); /* 변수 y를 입력 받음 */

    sum = x + y;         

    /* 두 수를 더해 변수 sum에 저장 */

    printf(“\n sum=%d”, sum); 

    /* 결과를 화면에 출력 */

}

프로그램 전체에
적용되는 사항 기술

main() 함수는 가장
먼저 호출되는 함수로 
모든 프로그램에 존재

main()함수에서
호출된 함수들에 
대한 정의 부분

#include <stdio.h>
int main()
{

    printf(“Today “);

    printf(“is “);

    printf(“Sunday”);

    printf(“\n”);
} 

도입부

int main()
{
   선언문
   치환문
   제어문
   함수호출
}

호출된 함수()
{
}

Today is Sunday
출력

#include <stdio.h>
int main()
{

    printf(“Today\n“);

    printf(“is\n“);

    printf(“Sunday\n”);
}

Today
is
Sunday

출력
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02
Java프로그래밍

‘Java프로그래밍’ 과목의 학습 목표는 ‘프로그램을 이용한 문제 해결 능력의 배양’과 ‘Java 

언어를 이용한 응용 프로그램의 개발 능력 함양’이다. Java 언어를 학습하려면 작업 환경을 

먼저 마련해야 한다. 여기서는 Java 프로그래밍을 위한 준비 작업과 작성된 Java 프로그램을 

실행하는 절차를 간단히 설명하기로 한다. Java 개발 도구로는 오픈소스의 통합 개발 환경을 

지원하는 Eclipse를 활용한 예를 보이겠다.

학습개요

1. Java SE Development Kit의 설치

1 가장 우선해야 할 작업은 ‘Java SE Development Kit(JDK)’를 설치하는 일이다. 오라클의 
홈페이지에 접속하여 찾아갈 수도 있으며, 다음의 주소를 브라우저의 주소란에 입력하면 된다. 
이미 JDK-9 이상이 설치되어 있다면 굳이 최신 버전을 설치할 필요는 없다. 
 https://www.oracle.com/java/technologies/downloads/#jdk25-windows
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위와 같은 화면이 나오는데 64비트 윈도우 환경을 사용한다면 Windows 탭에서 ‘x64 In-
staller’에 해당하는 ‘jdk-25_windows-x64_bin.exe’를 클릭하여 설치 파일을 다운로드
받아 저장한다. 저장된 파일을 찾아 실행하면 ‘JDK 25’를 설치할 수 있다. 설치 과정은 매우 
쉬우니 넘어가기로 한다.

2

2. 환경변수 JAVA_HOME의 설정

1 윈도우 버전에 따라 약간의 차이는 있으나 윈도우 시작 메뉴       를 누르고 ‘설정’        을 찾아
실행한 후, 나타나는 창에서 ‘환경변수’를 검색하고, ‘시스템 환경변수 편집’을 선택하면 
‘시스템 속성’ 대화상자가 열린다. 이어서 아래와 같은 방법으로 ‘시스템 변수’로서 ‘JAVA_
HOME’을 만들 수 있다. 

아래의 ‘환경 변수’ 대화상자에서 ‘새로 만들기’ 버튼을 클릭하고 ‘새 시스템 변수’ 대화상
자에서 이름은 ‘JAVA_HOME’으로, 값은 ‘C:\Program Files\Java\jdk-25’로 한다
(입력 시 따옴표는 빼야 한다). JDK가 설치된 경로는 JDK 버전에 따라 약간 다를 수 있으
므로 확인이 필요하다.

2
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다운로드받은 파일은 압축파일(.zip)이다. 적당한 위치에 압축을 푸는 것만으로 Eclipse를 
설치할 수 있다. 물론 설치 파일(.exe)을 다운로드받아 설치할 수도 있다. 아래 그림은 
D:\에 압축을 푼 후, 파일 탐색기로 확인한 것이다. Eclipse 실행 파일인 eclipse.exe가 
존재하는 것을 확인하도록 한다.

2

3. Eclipse의 설치

1 브라우저를 이용해 주소란에 https://www.eclipse.org/downloads/packages/를 입력
하여 접속하면 아래와 같은 화면이 나온다. 여기서 윈도우용 ‘Eclipse IDE for Java De-
velopers’를 다운로드받도록 한다. 64비트 윈도우 운영체제를 사용한다면 아래 그림과 같다.

명령 프롬프트 창에서 자바를 실행하는 경우도 있으므로, 기존에 존재하는 ‘PATH’ 환경
변수에 경로 ‘C:\Program Files\Java\jdk-25\bin’를 추가하는 것도 좋다.

3
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다음에 나타나는 화면을 ‘Java perspective’의 워크벤치라고 한다(마지막 그림). Eclipse가
다양한 언어를 지원하는 도구임을 기억하자. 워크벤치 안에는 다양한 정보를 보여주는 뷰
(사각 영역)와 편집기가 포함되어 있다.

Eclipse를 이용해 Java 프로그램을 개발하려면 먼저 프로젝트를 만들어야 한다. 프로젝트는 
관련이 있는 소스와 클래스 등의 여러 자원을 관리하기 위한 단위이다. 교재 1장에 나오는 
소스 프로그램들을 ‘chap01’이라는 이름의 프로젝트로 관리해 보자. 교재 2장에 나오는 
소스 프로그램들은 프로젝트 ‘chap02’로 관리하면 된다.

메뉴에서 File>New>‘Java Project’ 순으로 선택한 후, 나타나는 대화창에서 프로젝트 
이름으로 ‘chap1’을 입력한다. 그리고 대화창의 하단에 “Create module-info.java” 가 
체크 해제되었는지 확인한 후 ‘Finish’를 클릭한다. 워크벤치 좌측의 ‘Package Explorer’ 
뷰에서 생성된 프로젝트 이름을 확인할 수 있다.

실수로 “module-info.java” 파일을 만들었다면 ‘Package Explorer’ 뷰에서 오른 마우스 
버튼을 이용하여 삭제하도록 한다.

2

3

4

5

4. Eclipse의 사용

1 eclipse.exe를 처음 실행하면 작업공간(workspace)을 정하는 팝업창이 뜰 것이다. 작업
공간은 사용자 작업(또는 프로젝트)을 저장할 기본 폴더를 의미한다. 작업공간은 차후에 
Eclipse 메뉴에서 Window>Preferences의 General>Workspace를 통해 변경이 가능
하다. 다음에는 아래 그림과 같은 환영(Welcome) 화면이 나올 것이다. Welcome 화면을 
종료시키고 워크벤치(workbench)로 이동한다.
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‘New Java Class’ 대화상자에서 클래스 이름으로 ‘HelloApplication’을 입력하고 종료한다.

워크벤치 안의 편집기에서 교재의 소스 프로그램을 작성해 보자. 작성 중에 문법적 오류가 
있는지 즉시 확인할 수 있을 것이다. 프로그램 작성을 끝낸 후, 프로그램을 컴파일하고 실행
하려면 화살촉 모양의 버튼을 클릭한다. 워크벤치 아래의 Console 뷰에서 실행 결과를 
볼 수 있을 것이다.

7

8

6 자바 소스 프로그램을 만들려면, ‘Package Explorer’ 뷰에서 프로젝트 이름을 오른 마우스
버튼으로 클릭한 다음 New>Class 순으로 선택한다. 아래 그림과 같다. 
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데이터베이스시스템

[데이터베이스 시스템] 과목에서는 데이터베이스 시스템을 직접 설계하고 구현하기 위해 MyS-

QL 서버와 MySQL 워크벤치를 사용한다. 여타의 상용 DBMS과 다르게 MySQL이 갖는 가장 

큰 장점은 DBMS로서의 기능 및 성능이 대용량의 데이터를 감당하는 서비스 현장에서 사용하기

에도 충분히 우수할 뿐만 아니라 GPL(General Public License: 일반 공중 사용 허가서)이 

적용되는 Community 에디션을 제공하여 특별한 비용 지불없이 자유롭게 수정 및 사용할 수 

있다는 점이다. 또한 MySQL은 DBMS를 GUI 환경에서 쉽고 편리하게 설계‧관리할 수 있는 

MySQL 워크벤치(MySQL Workbench)라는 CASE 툴을 제공한다.
 

MySQL 서버와 Mysql 워크벤치의 다운로드 및 설치, 그리고 데이터베이스 모델링 과정에서 

한글명칭 사용을 위한 설정 방법에 대해서 알아보자. 

설치 및 설정 환경은 강의에서 사용한 Microsoft Windows 11 및 관리자 계정을 기준으로 한다. 

학습개요
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“General Available (GA) Release” 탭에서 먼저 운영체제를 Microsoft Windows를 
선택한 후, [그림 2]와 같이 Windows (x86, 32-bit), MSI Installer 설치파일을 Down-
load 버튼을 클릭한다. (64 bit 운영체제에서도 정상적으로 동작한다.)

2

1

[그림2 ] MySQL Installer 다운로드 화면

1. MySQL Installer 다운로드 

MySQL Installer 다운로드를 위해 웹브라우저에서 아래와 같은 URL을 사용하여 [그림 
1]과 같이 MySQL 사이트에 먼저 접속한다. 그림의 빨간 상자는 MySQL Installer에서 
설치할 수 있는 항목들을 나타낸다.

http://dev.mysql.com/downloads/installer/

[그림 1] http://dev.mysql.com/downloads/installer 접속화면
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주의사항
·  MySQL 제품은 한글과 같이 2바이트 문자를 적절히 지원하지 못한다. 따라서 컴퓨터이름, 사용자  
   이름, MySQL Installler.exe 파일 저장 경로에 한글이 있는지 반드시 확인하고 한글이 있는  
   경우 영문으로 변경을 권장한다.  

· 설치 과정에서 발생할 수 있는 문제를 최소화하기 위해 MySQL
   Installer.exe 실행 시 관리자 권한으로 실행하는 것을 권장한다. 

3 Download 버튼 클릭 후, 사용자 계정을 생성하지 않고 곧바로 다운로드를 시작하기 
위해서 [그림 3]과 같이 하단의 ‘No thanks, just start my download’를 선택한다. 

[그림 3] 로그인 화면

MySQL Installer를 다운로드한 실행 파일을 실행하여 프로그램 설치를 시작한다. 
‘Choosing a Setup Type’ 화면에서는 데이터베이스의 사용 목적에 따라 MySQL의 
기능적 유형을 결정하는 화면이다. [데이터베이스 시스템] 과목에는 데이터베이스 사용
뿐만 아니라 웹 프로그램과 연동하는 응용 기능까지 사용하므로 [그림 4]에서 ‘Full’을 
선택한 후 ‘Next’ 버튼을 누른다.

1
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Setup Type이 결정되면 [그림 5]와 같이 Check Requirements를 진행한다. Check 
Requirements 화면은 MySQL 및 MySQL 워크벤치 실행에 필요한 외부 응용프로그
램이 정상적으로 설치되어 있는지 확인하는 프로그램이다. 사용자의 컴퓨터에 설치된 
프로그램의 상태에 따라 사용자마다 다르게 보일 수 있다.

2

[그림 5] Check Requirements 화면

[그림 4] Setup Type 단계
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3 반드시 필요한 응용프로그램이 설치되어 있지 않다면 자동으로 인터넷에서 다운로드
하여 설치되므로 [그림 6-7]과 같이 한 항목 씩 선택하여 ‘Execute’ 버튼을 선택한다. 

[그림 6] Check Requirements 단계

[그림 7] Microsoft Visual C++ 모듈 설치 화면



필요한 외부프로그램의 설치가 완료되면 [그림 6]의 ‘Next’ 버튼을 선택하여 [그림 8]과 
같이 실제 MySQL 프로그램 설치를 진행할 수 있다. MySQL 워크벤치 설치에 필요한 모든 
프로그램 항목에 대한 목록이 표시된다. 
[그림 2]에서 Web Installer가 아닌 Full Installer가 선택되었기 때문에  [그림 8]에서는 
별도의 다운로드 과정 없이 곧바로 설치 가능한 ‘Ready to Install’로 표시된다. 필요한 
프로그램의 목록이 작성되면 ‘Execute’ 버튼을 선택하면 [그림 9]와 같이 MySQL 사용에 
필요한 각 구성요소가 다운로드되면서 설치를 시작한다.  

4

[그림 8] Installation 준비 단계

[그림 9] Installation 단계 03
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6 [그림 11] 서버 네트워크 설정 단계는 MySQL Server에 접속할 수 있는 방식을 설정하는 
단계이다. MySQL은 기본적으로 3306 포트 번호를 사용하며 상황에 따라 변경가능하다. 
별도의 수정이 필요없는 경우 Config Type은 ‘Development Computer’로 설정하고 
연결 방식은 TCP/IP 방식으로 설정한 후 ‘Next’ 버튼을 누른다.

[그림 11] 서버 네트워크 설정 단계

5 모든 항목에 대한 설치가 완료되면 [그림 10]과 같이 MySQL 서버 실행에 필요한 옵션을 
설정하게 된다. 

[그림 10] Product Configuration 단계

- 설치 시 Server나 Full을 선택할 경우 MySQL Server의 운용형태, 접속에 필요한 네트워크, 사용자, 
윈도우 서비스 등을 설정한다. [그림 10]과 같이 특별한 설정을 변경할 필요 없이 기본값으로 ‘Next’ 
버튼을 눌러 진행한다. 
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8 [그림 13]의 ‘Account and Roles’ 화면은 MySQL Server 설정에서 매우 중요한 루트
(root) 계정의 암호 설정과 사용자 계정 생성한다. 루트 계정은 MySQL의 최고 권한 계정
으로 DBMS 사용에 필요한 모든 권한이 할당된다. 따라서 유추하기 어려운 암호를 선택
해야하며 학습자가 반드시 암호를 기억하고 있어야 한다. 

[그림 13] 서버 사용자 설정 단계

7 [그림 12] 인증 방식 설정 화면은 사용자 패스워드의 암호화(해싱) 방식을 결정한다. MySQL 
버전 8 이상부터는 패스워드에 SHA256을 적용하는 방식을 사용하여 보안성을 향상시킨다. 
[그림 14]와 같이 강력한 암호 보호 방식을 사용하여 ‘Next’ 버튼을 누른다. 

[그림 12] 인증 방식 설정 단계
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10 [그림 15]의 서버 파일 권한 부여 단계는 부가적으로 MySQL 서버 데이터가 저장되는 폴더인 
C:\ProgramData\MySQL\MySQL Server 8.0\Data와 이 폴더에 저장된 파일에 접근
할 수 있는 권한을 윈도우 서비스를 실행하는 사용자 계정에 부여할 것인지를 설정한다. 
첫 번째 옵션을 선택할 경우 사용자에게 파일의 모든 권한이 부여되며 타 사용자 계정은 
접근이 거절된다. 두 번째 옵션은 개별 파일에 접근 수준을 직접 확인하여 부여하는 것이며 
마지막 옵션은 서버 설정 이후 별도로 접근 권한을 부여하는 것을 뜻한다. 실제 서버 설치 
시 보안 관점에서 두 번째 또는 세 번째 옵션 선택이 권장되나 개발 목적으로 사용하는 
만큼 편리한 첫 번째 옵션을 선택한다. 

9 [그림 14]는 MySQL의 윈도우 서비스 이름을 설정하는 화면이다. 응용 프로그램에서 
MySQL과 연동하기 위해서는 서비스 이름이 반드시 필요하다. 기본값으로 ‘MySQL 80’ 
설정되어 있다. 또한 ‘Start a MySQL Server at System Startup’ 옵션을 선택하면 윈도
우 부팅 시 자동으로 MySQL이 실행되도록 할 수 있다. ‘Standard System Account’를 
선택하고 ‘Next’를 누르면 설정이 완료된다. 

[그림 14] 윈도우 서비스 설정 단계

[그림 15] 서버 파일 권한 부여 단계
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11 [그림 16]은 설정 적용 화면은 앞서 설정한 MySQL Server의 사항을 실제 서버에 적용하는 
단계로 설정의 변경없이 ‘Execute’, ‘Finish’, ‘Next’버튼을 사용하여 [그림 17]의 Connect 
to Server 단계까지 진행한다. 

[그림 16] 설정 적용 단계

[그림 17] 연결 테스트 단계
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12 [그림 18]의 연결 테스트 단계를 설치 완료 전, 설치된 MySQL Server에 루트(root) 
계정으로 접속이 가능한지 최종 테스트하는 화면으로 [그림 13]에서 입력한 암호를 입력
하여 ‘Check’ 버튼을 눌러 접속 가능 여부를 테스트 한 후 ‘Next’ 버튼으로 다음 단계로 
진행할 수 있다. 

[그림 18] 설치 완료 단계

13

이후 [그림 18]의 설치 완료 단계에 이를 때까지 별도의 설정 변경없이  ‘Finish’, ‘Next’
버튼을 사용하여 진행한 후 설치를 완료할 수 있다. 

설치 후 [시작]->[모든 프로그램]에서 MySQL 그룹이 생성된 것을 [그림 19]와 같이 확인
할 수 있으며, 그룹 내에 MySQL 워크벤치 8.0 CE와 여러 제품에 대한 그룹이 생성된 것을 
확인할 수 있다. [그림 20]은 MySQL 워크벤치 8.0 CE 선택 후 실행된 MySQL 워크벤치 
실행 화면이다. 

[그림 19] MySQL 메뉴
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[그림 20] MySQL 워크벤치 메인 화면

1

MySQL 워크벤치 8.0 CE 버전은 부족하게도 아직 한글화 및 한글 지원이 완전하지 않아 
메뉴 및 여러 설명(help)​이 영문으로만 되어 있으며 한국 사용이 원활하지 않다. 그러나 
간단한 조작으로 한글을 객체의 이름이나 필드의 이름으로 사용할 수 있다. 

[그림 21]과 같이 우선 상단 메뉴에서 [Edit]->[Preferences] 항목을 선택하면 [그림 22]와 
같은 Workbench Preferences 화면이 생성된다.

[그림 21] Edit 메뉴 

3. MySQL 워크벤치에서의 한글 사용법
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[그림 22] MySQL 워크벤치 Preference 설정 화면

2 ‘Preferences’ 화면에서 왼쪽 메뉴 중간의 ‘Appearance’ 탭을 클릭하면 [그림 23]과 같이 
화면의 색상과 글꼴(폰트)를 설정할 수 있는 화면으로 변경된다. 

- [그림 23]의 ‘Configure Fonts For..’ 콤보박스를 Korean으로 변경한 후 모든 항목이 ‘Arial  
   Unicode MS 11’로 변경된 것을 확인한 후 ‘OK’ 버튼을 선택하면 한글 사용이 가능해진다.

[그림 23] MySQL 워크벤치 Preference의 폰트 설정 화면
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3 만약 ‘Arial Unicode’ 폰트 이외에 자신이 사용하고 싶은 폰트를 적용하려면 [그림 24]와 
같이 각 항목을 세 번 클릭한 후 폰트명을 직접 입력해야한다. 단, 폰트명을 잘못 입력하
더라도 오류표시가 되지 않으므로 신중히 입력해야 한다. 

[그림 24] MySQL 워크벤치 Preference의 폰트 변경 화면
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 안드로이드 프로그래밍 개발 툴 설정 및 예제 실행

1. 안드로이드 스튜디오 설치하기

안드로이드 스튜디오 프로그램을 설치해 보겠습니다.
- https://developer.android.com/studio?hl=ko  (버전에 따라서 화면은 다를 수 있습니다.)

학습개요

1
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라이선스에 동의를 하고 다운로드를 시작합니다.3

Windows 64비트용은 위의 화면에서 ANDROID 스튜디오 다운로드 버튼을 클릭하면 
됩니다. 
- 다른 버전인 경우(32-bit등) 아래의 다운로드 옵션을 클릭하여 실행파일을 다운로드하여 설치
  하시면 됩니다. 

2
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다운로드 받은 파일을 더블 클릭하여 실행합니다. 설치 마법사가 나타나면, Next>를 
클릭하여 진행합니다.

다음 화면은 설치 옵션을 선택하는 창입니다. 가상 드라이브(AVD)가 기본으로 체크된 것
을 확인 할 수 있습니다. 모두 선택이 되었는지 확인 후 Next> 버튼을 클릭합니다.  

4

5
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아래 화면에서는 Install 버튼을 클릭하여 설치를 시작합니다. Android studio 라는 
이름의 아이콘이 생성되어 프로그램이 설치될 것입니다.

7

안드로이드 스튜디오 프로그램이 설치될 경로를 지정하는 화면입니다. 기본 경로를 그대로
사용하거나 변경하길 원하는 위치를 지정하면 됩니다. Next> 버튼을 클릭하여 다음 단계로 
넘어갑니다.

6
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설치가 성공적으로 완료되었다는 메시지가 출력됩니다. Next > 버튼을 눌러 마지막 단계로 
넘어갑니다. 

9

설치 버튼을 클릭했다면, 아래의 화면과 같이 설치가 진행될 것입니다. 시간이 다소 걸릴   수 
있습니다. 조금만 참고 기다리시면 다시 Next> 버튼이 보입니다.

8
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안드로이드 스튜디오의 관련 기능을 사용하는 것에 대해서 구글에서 정보를 수집할 수 
있도록 허용할지에 대한 내용입니다. 전송하기 싫으신 경우에는 “Don’t send”를 선택
하시면 되고, 전송해도 상관없는 경우에는 “Send usage statistics to Google”을 
누르면 됩니다. 설치를 계속하기 위해 Next> 버튼을 클릭합니다.

11

설치가 완료되면 Start Android Studio 옵션에 체크를 하시고 Finish 버튼을 클릭합니다. 10
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Verify Settings 파일에서 Next> 버튼을 클릭합니다.13

설치 시 “Standard” 설치 옵션을 선택하는 것을 일반적으로 권장합니다. 이 옵션은 
기본적인 개발 환경과 함께 Android SDK, Android Emulator, 기본 도구들을 포함합니다. 
옵션을 확인하고 Next> 버튼을 클릭합니다.

12
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필요한 Components를 모두 설치한 이후 Finish 버튼을 클릭합니다.15

License Agreement 페이지에서 좌측에 있는 모든 Licenses에 Accept를 진행한 이후 
Finish 버튼을 클릭합니다.

14
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애플리케이션을 개발할 때, 기본, 빈 테마(Empty Views Activity)를 선택해서 진행하겠
습니다. Next> 버튼을 클릭합니다.

17

모든 절차를 마무리했다면 안드로이드 스튜디오의 환경설정이 정상적으로 마무리되었
습니다. 다음으로 새 프로젝트를 실행해 보기 위해 “New Project” 버튼을 클릭해 보
겠습니다.

16
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시작 화면이 나타나면서 loading 표시가 나타납니다. 최종화면이 나타날 때까지 충분히 
기다려주시길 바랍니다. 최종화면이 다음과 같이 나타납니다. 왼쪽 화면에서는 경로를 
확인할 수 있습니다. 가운데 화면의 상단 탭 메뉴에서 .xml 파일과 .kt 파일을 선택하여 
작업할 수 있습니다.

19

18 프로젝트의 이름을 설정하는 부분입니다. 
- 자동으로 설정되는 이름은 My Application입니다. 
- 애플리케이션 이름을 입력하고 프로젝트 위치를 선택합니다.
- 그 외 설정은 내용을 확인한 후에 “Finish” 버튼을 클릭하여 프로젝트를 생성합니다.
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안드로이드 스튜디오를 설치할 때 기본적으로 Dark 모드로 설치됩니다. 작업 화면 색을 변
경하고자 하시는 경우 다음과 같이 하시면 됩니다. 
- File → settings를 클릭합니다.
- 왼쪽 항목의 Appearance & Behavior에서 Appearance를 클릭합니다.

1

왼쪽 화면에서 MainActivity 파일과 activity_main 파일이 어느 폴더에 있는지 확인해 
보시면 좋을 것 같습니다. 교재에서 사용되는 폴더들과 파일들을 왼쪽 화면에서 직접 
확인해 보시길 바랍니다. 가운데 화면에서 activity_main 파일을 보시면, 기본으로 작성
된 Hello World 코드를 확인하실 수 있습니다. 첫 번째 프로젝트를 실행(Run)시켜 보도록
하겠습니다. 오른쪽에서 미리 설정된 AVD 장치에 맞춰서 실행되는 것을 확인할 수 있습니다.

20

2. 작업 화면 색 모드 변경 방법
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안드로이드 스튜디오 개발자 사이트에서도 설치와 관련하여 설명을 제공하고 있습니다. 
버전도 많이 다양해지고, 다양한 버전에 맞춰서 여러 가지 기능들이 빠르게 변화되어 제공
되고 있습니다. 안드로이드 스튜디오 개발자 사이트에서 도움이 되실만한 설명들이 제공
되고 있습니다. 참고하시면 도움이 되실 것 같아서 URL 주소를 알려드립니다. 캡처한 화면
보다 동영상을 보시면 도움이 되실 것 같습니다.
(https://developer.android.com/studio/intro/migrate?hl=ko)

설치만 하셔도 많은 걸 해내신 것입니다. 꼭 성공하시길 바랍니다!!

6

- Theme 항목에서 Light 또는 원하시는 모드로 변경합니다.



당신의 꿈을
응원합니다!

컴퓨터과학과와 함께하는 당신이 주인공입니다

온라인 배포 금지


